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Abstract—These instructions give you guidelines for preparing abstracts for the Fully 3D 2007 Meeting. It is based on the “Peparation of Papers for the IEEE Transactions and Journals (March 2004). Use this document as a template if you are using Microsoft Word 6.0 or later. Otherwise, use this document as an instruction set. The electronic file of your paper will be formatted further at IEEE. Define all symbols used in the abstract. Do not cite references in the abstract. Do not delete the blank line immediately above the abstract; it sets the footnote at the bottom of this column.

Index Terms—About four key words or phrases in alphabetical order, separated by commas. For a list of suggested keywords, send a blank e-mail to keywords@ieee.org or visit the IEEE web site at http://www.ieee.org/organizations/pubs/ani_prod/keywrd98.txt
I. INTRODUCTION
This document is a template for Microsoft Word versions 6.0 or later. If you are reading a paper version of this document, please download the electronic file, TRANS-JOUR_Fully3d.doc, from http://www.fully3d.org/2007/authors.htm so you can use it to prepare your manuscript. If you would prefer to use LATEX, download IEEE’s LATEX style files (IEEEtran) from 
http://www.ieee.org/web/publications/authors/transjnl/index.html and the sample file from http://www.fully3d.org/2007/authors.htm. Use these LATEX files for formatting, but please follow the instructions in  TRANS-JOUR_Fully3d.doc.
When you open TRANS-JOUR_Fully3d.doc, select “Page Layout” from the “View” menu in the menu bar (View | Page Layout), which allows you to see the footnotes. Then type over sections of TRANS-JOUR_Fully3d.doc or cut and paste from another document and then use markup styles. The pull-down style menu is at the left of the Formatting Toolbar at the top of your Word window (for example, the style at this point in the document is “Text”). Highlight a section that you want to designate with a certain style, then select the appropriate name on the style menu. The style will adjust your fonts and line spacing. Do not change the font sizes or line spacing to squeeze more text into a limited number of pages. Use italics for emphasis; do not underline. 

To insert images in Word, position the cursor at the insertion point and either use Insert | Picture | From File or copy the image to the Windows clipboard and then Edit | Paste Special | Picture (with “Float over text” unchecked). 

If your paper is intended for a conference, please observe the conference page limits. 

II. Procedure for Paper Submission

A. PaperSubmission

For the submission of your abstract convert the final version  to pdf and submit it as an e-mail attachment to abstract@fully3d.org. Please state the first author and the title in the subject line of the e-mail and provide the filename of the pdf in the e-mail body. If you want to get a receipt, make sure that your e-mail configuration require a return receipt. 

 Please check with your editor on whether to submit your manuscript by hard copy or electronically for review. If hard copy, submit photocopies such that only one column appears per page. This will give your referees plenty of room to write comments. Send the number of copies specified by your editor (typically four). If submitted electronically, find out if your editor prefers submissions on disk or as e-mail attachments.

If you want to submit your file with one column electronically, please do the following:


--First, click on the View menu and choose Print Layout.


--Second, place your cursor in the first paragraph. Go to the Format menu, choose Columns, choose one column Layout, and choose “apply to whole document” from the dropdown menu.


--Third, click and drag the right margin bar to just over 4 inches in width.

The graphics will stay in the “second” column, but you can drag them to the first column. Make the graphic wider to push out any text that may try to fill in next to the graphic.

B. [image: image4.png]°
°
_ 20 40

o
—

| | | | |
< AN o O (@) < AN o
-— — -—

(w/yy) uoneznaubepy

Applied Field (104 A/m)



Copyright Form

An IEEE copyright form should accompany your final submission. You can get a .pdf, .html, or .doc version at http://www.ieee.org/copyright or from the first issues in each volume of the IEEE TRANSACTIONS and JOURNALS. Authors are responsible for obtaining any security clearances.

III. MATH
If you are using Word, use either the Microsoft Equation Editor or the MathType add-on (http://www.mathtype.com) for equations in your paper (Insert | Object | Create New | Microsoft Equation or MathType Equation). “Float over text” should not be selected. 

IV. Units

Use either SI (MKS) or CGS as primary units. (SI units are strongly encouraged.) English units may be used as secondary units (in parentheses). This applies to papers in data storage. For example, write “15 Gb/cm2 (100 Gb/in2).” An exception is when English units are used as identifiers in trade, such as “3½ in disk drive.” Avoid combining SI and CGS units, such as current in amperes and magnetic field in oersteds. This often leads to confusion because equations do not balance dimensionally. If you must use mixed units, clearly state the units for each quantity in an equation.

The SI unit for magnetic field strength H is A/m. However, if you wish to use units of T, either refer to magnetic flux density B or magnetic field strength symbolized as µ0H. Use the center dot to separate compound units, e.g., “A·m2.”

V. Helpful Hints

A. Figures and Tables

Because there will not be any further formatting of your paper, you are responsible for the final position of figures and tables (e.g. at the top and bottom of each column). Place figure captions below the figures; place table titles above the tables. Please verify that the figures and tables you mention in the text actually exist. Please do not include captions as part of the figures. Do not put captions in “text boxes” linked to the figures. Do not put borders around the outside of your figures. Use the abbreviation “Fig.” even at the beginning of a sentence. Do not abbreviate “Table.” Tables are numbered with Roman numerals. 

For the online version of the proceedings colored presentation of the figures is available but it is not for the printed version. If you use color for your figures make sure that the proper interpretation is possible if printed using grayscale. Figure axis labels are often a source of confusion. Use words rather than symbols. As an example, write the quantity “Magnetization,” or “Magnetization M,” not just “M.” Put units in parentheses. Do not label axes only with units. As in Fig. 1, for example, write “Magnetization (A/m)” or “Magnetization (A
[image: image1.wmf]×

m(1),” not just “A/m.” Do not label axes with a ratio of quantities and units. For example, write “Temperature (K),” not “Temperature/K.” 

Multipliers can be especially confusing. Write “Magnetization (kA/m)” or “Magnetization (103 A/m).” Do not write “Magnetization (A/m) ( 1000” because the reader would not know whether the top axis label in Fig. 1 meant 16000 A/m or 0.016 A/m. Figure labels should be legible, approximately 8 to 12 point type.

B. References

Number citations consecutively in square brackets [1]. The sentence punctuation follows the brackets [2]. Multiple references [2], [3] are each numbered with separate brackets [1]–[3]. When citing a section in a book, please give the relevant page numbers [2]. In sentences, refer simply to the reference number, as in [3]. Do not use “Ref. [3]” or “reference [3]” except at the beginning of a sentence: “Reference [3] shows ... .” Unfortunately the IEEE document translator cannot handle automatic endnotes in Word; therefore, type the reference list at the end of the paper using the “References” style.

Number footnotes separately in superscripts (Insert | Footnote).
 Place the actual footnote at the bottom of the 
[image: image2]column in which it is cited; do not put footnotes in the reference list (endnotes). Use letters for table footnotes (see Table I). 

Please note that the references at the end of this document are in the preferred referencing style. Give all authors’ names; do not use “et al.” unless there are six authors or more. Use a space after authors' initials. Papers that have not been published should be cited as “unpublished” [4]. Papers that have been submitted for publication should be cited as “submitted for publication” [5]. Papers that have been accepted for publication, but not yet specified for an issue should be cited as “to be published” [6]. Please give affiliations and addresses for private communications [7].

Capitalize only the first word in a paper title, except for proper nouns and element symbols. For papers published in translation journals, please give the English citation first, followed by the original foreign-language citation [8].

C. Abbreviations and Acronyms

Define abbreviations and acronyms the first time they are used in the text, even after they have already been defined in the abstract. Abbreviations such as IEEE, SI, ac, and dc do not have to be defined. Abbreviations that incorporate periods should not have spaces: write “C.N.R.S.,” not “C. N. R. S.” Do not use abbreviations in the title unless they are unavoidable (for example, “IEEE” in the title of this article).

D. Equations

Number equations consecutively with equation numbers in parentheses flush with the right margin, as in (1). First use the equation editor to create the equation. Then select the “Equation” markup style. Press the tab key and write the equation number in parentheses. To make your equations more compact, you may use the solidus ( / ), the exp function, or appropriate exponents. Use parentheses to avoid ambiguities in denominators. Punctuate equations when they are part of a sentence, as in


[image: image3.wmf].

)

(

)

(

)

|

|

(

exp

)]

2

(

/

[

)

,

(

0

2

1

1

0

0

2

0

2

l

l

l

l

l

m

s

j

j

d

r

J

r

J

z

z

r

d

dr

r

F

i

i

j

r

-

¥

-

-

×

=

ò

ò


(1)

Be sure that the symbols in your equation have been defined before the equation appears or immediately following. Italicize symbols (T might refer to temperature, but T is the unit tesla). Refer to “(1),” not “Eq. (1)” or “equation (1),” except at the beginning of a sentence: “Equation (1) is ... .”

E. Other Recommendations

Use one space after periods and colons. Hyphenate complex modifiers: “zero-field-cooled magnetization.” Avoid dangling participles, such as, “Using (1), the potential was calculated.” [It is not clear who or what used (1).] Write instead, “The potential was calculated by using (1),” or “Using (1), we calculated the potential.”

Use a zero before decimal points: “0.25,” not “.25.” Use “cm3,” not “cc.” Indicate sample dimensions as “0.1 cm ( 0.2 cm,” not “0.1 ( 0.2 cm2.” The abbreviation for “seconds” is “s,” not “sec.” Do not mix complete spellings and abbreviations of units: use “Wb/m2” or “webers per square meter,” not “webers/m2.” When expressing a range of values, write “7 to 9” or “7-9,” not “7~9.”

A parenthetical statement at the end of a sentence is punctuated outside of the closing parenthesis (like this). (A parenthetical sentence is punctuated within the parentheses.) In American English, periods and commas are within quotation marks, like “this period.” Other punctuation is “outside”! Avoid contractions; for example, write “do not” instead of “don’t.” The serial comma is preferred: “A, B, and C” instead of “A, B and C.”

If you wish, you may write in the first person singular or plural and use the active voice (“I observed that ...” or “We observed that ...” instead of “It was observed that ...”). Remember to check spelling. If your native language is not English, please get a native English-speaking colleague to proofread your paper. 

VI. Some Common Mistakes

The word “data” is plural, not singular. The subscript for the permeability of vacuum µ0 is zero, not a lowercase letter “o.” The term for residual magnetization is “remanence”; the adjective is “remanent”; do not write “remnance” or “remnant.” Use the word “micrometer” instead of “micron.” A graph within a graph is an “inset,” not an “insert.” The word “alternatively” is preferred to the word “alternately” (unless you really mean something that alternates). Use the word “whereas” instead of “while” (unless you are referring to simultaneous events). Do not use the word “essentially” to mean “approximately” or “effectively.” Do not use the word “issue” as a euphemism for “problem.” When compositions are not specified, separate chemical symbols by en-dashes; for example, “NiMn” indicates the intermetallic compound Ni0.5Mn0.5 whereas “Ni–Mn” indicates an alloy of some composition NixMn1-x.

Be aware of the different meanings of the homophones “affect” (usually a verb) and “effect” (usually a noun), “complement” and “compliment,” “discreet” and “discrete,” “principal” (e.g., “principal investigator”) and “principle” (e.g., “principle of measurement”). Do not confuse “imply” and “infer.” 

Prefixes such as “non,” “sub,” “micro,” “multi,” and “"ultra” are not independent words; they should be joined to the words they modify, usually without a hyphen. There is no period after the “et” in the Latin abbreviation “et al.” (it is also italicized). The abbreviation “i.e.,” means “that is,” and the abbreviation “e.g.,” means “for example” (these abbreviations are not italicized).

An excellent style manual and source of information for science writers is [9]. A general IEEE style guide, Information for Authors, is available at http://www.ieee.org/organizations/pubs/transactions/information.htm
VII. Editorial Policy

Submission of a manuscript is not required for participation in a conference. Do not submit a reworked version of a paper you have submitted or published elsewhere. Do not publish “preliminary” data or results. The submitting author is responsible for obtaining agreement of all coauthors and any consent required from sponsors before submitting a paper. IEEE TRANSACTIONS and JOURNALS strongly discourage courtesy authorship. It is the obligation of the authors to cite relevant prior work.

At least two reviews are required for every paper submitted. For conference-related papers, the decision to accept or reject a paper is made by the conference editors and publications committee; the recommendations of the referees are advisory only. Undecipherable English is a valid reason for rejection. Authors of rejected papers may revise and resubmit them to the TRANSACTIONS as regular papers, whereupon they will be reviewed by two new referees.

VIII. Conclusion

A conclusion section is not required. Although a conclusion may review the main points of the paper, do not replicate the abstract as the conclusion. A conclusion might elaborate on the importance of the work or suggest applications and extensions. 

Appendix

Appendixes, if needed, appear before the acknowledgment.

Acknowledgment

The preferred spelling of the word “acknowledgment” in American English is without an “e” after the “g.” Use the singular heading even if you have many acknowledgments. Avoid expressions such as “One of us (S.B.A.) would like to thank ... .” Instead, write “F. A. Author thanks ... .” Sponsor and financial support acknowledgments are placed in the unnumbered footnote on the first page.
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TABLE I


Units for Magnetic Properties


Symbol�
Quantity�
Conversion from Gaussian and


CGS EMU to SI a�
�
(�
magnetic flux�
1 Mx ( 10(8 Wb = 10(8 V·s�
�
B�
magnetic flux density, 


  magnetic induction�
1 G ( 10(4 T = 10(4 Wb/m2�
�
H�
magnetic field strength�
1 Oe ( 103/(4() A/m�
�
m�
magnetic moment�
1 erg/G = 1 emu 


  ( 10(3 A·m2 = 10(3 J/T�
�
M�
magnetization�
1 erg/(G·cm3) = 1 emu/cm3


  ( 103 A/m�
�
4(M�
magnetization�
1 G ( 103/(4() A/m�
�
(�
specific magnetization�
1 erg/(G·g) = 1 emu/g ( 1 A·m2/kg�
�
j�
magnetic dipole 


  moment�
1 erg/G = 1 emu 


  ( 4( ( 10(10 Wb·m�
�
J�
magnetic polarization�
1 erg/(G·cm3) = 1 emu/cm3


  ( 4( ( 10(4 T�
�
(, (�
susceptibility�
1 ( 4(�
�
((�
mass susceptibility�
1 cm3/g ( 4( ( 10(3 m3/kg�
�
(�
permeability�
1 ( 4( ( 10(7 H/m 


  = 4( ( 10(7 Wb/(A·m)�
�
(r�
relative permeability�
( ( (r�
�
w, W�
energy density�
1 erg/cm3 ( 10(1 J/m3�
�
N, D�
demagnetizing factor�
1 ( 1/(4()�
�
No vertical lines in table. Statements that serve as captions for the entire table do not need footnote letters. 


aGaussian units are the same as cgs emu for magnetostatics; Mx = maxwell, G = gauss, Oe = oersted; Wb = weber, V = volt, s = second, T = tesla, m = meter, A = ampere, J = joule, kg = kilogram, H = henry.
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Fig. 1.  Magnetization as a function of applied field. Note that “Fig.” is abbreviated. There is a period after the figure number, followed by two spaces. It is good practice to explain the significance of the figure in the caption.











This work was supported in part by the U.S. Depart�ment of Com�merce under Grant BS123456 (sponsor and financial support acknowledgment goes here). Paper titles should be written in uppercase and lowercase letters, not all uppercase. Avoid writing long formulas with subscripts in the title; short formulas that identify the elements are fine (e.g., "Nd–Fe–B"). Do not write "(Invited)" in the title. Full names of authors are preferred in the author field, but are not required. Put a space between authors' initials. 
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�It is recommended that footnotes be avoided (except for the unnumbered footnote with the receipt date on the first page). Instead, try to integrate the footnote information into the text.
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